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Who is this meant for?

This booklet is meant for anyone who helps adults with choices about 
learning and work and who hasn’t used the Internet to do this before. If you
never had the time, or were put off, or too nervous to make a start, this
booklet is for you. It may also offer a few ideas to others with more 
experience of using the Internet in this context. 
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for their stimulating discussion and shared experiences. Thanks also to my wife.
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Why use the Internet in guidance anyway?

Open and Distance Learning

You can offer career development resources to more people in their own time and place
than ever before, and 24 hours a day, 7 days a week, provided the person you want to
support is able to access the Internet. The quality depends, as always in distance 
learning, on how well you frame and support the experience. 

Reaching More People

This is an extension of the previous point. Depending on the audience you serve, you
may be able to reach more people than ever before, including some you were unable to
serve without the Internet, perhaps because of distance or mobility problems or simply
because they were at work when your office was open. You can also network with fellow
practitioners more easily and frequently than before.

Access to Quality

You can access resources of a high quality from anywhere in the world at any time or
place if you’re on-line to the Internet. You don’t have to settle for second best just because
of where you live or work. Make sure you know how to tell quality from rubbish, though.

Raising your Game

If you have the interpersonal skills but not the specialised knowledge needed to support
someone in choosing learning or work, the use of a web site, an email or other Internet
link to such knowledge may make it possible for you to tackle issues you’d otherwise
have had to refer to someone else. You can operate at a higher level. 

Raising their Game
So can your clients - you may be faced with the “expert patient” as a result. You’ll need
to develop your own knowledge and skills. When people come to you for help, having
done some work on the Internet, e.g. on your organisation’s web site, they may come
with more precise and in-depth questions than they would have done without that.

Free Resources
Much of what is on the Web is still free. Even if you have to pay to get access via a 
password or similar, you may get the resource on-line cheaper than you would otherwise,
because the supplier doesn’t incur the costs of postage and packing. Communication is
also cheaper by email.

Direct Access

When information is on the World Wide Web, it can be kept up to date by the providers
themselves much more easily and regularly even than information supplied on a 
CD-ROM, let alone printed texts. You can get access directly to the databases at the
source of the information. You can also get direct access to people you couldn’t have
talked to before – by email and other Internet-based technology.
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So how do I get started?

You need to do four things:

1. Identify the groups you serve - who are they, and who should they be? (Not always the
same thing!)

2. Identify their needs - what, in your experience, do they ask about most often and what
do you think they need that they don’t ask about? Can you group these needs and 
questions into broad headings? 

3. Identify the resources available - what do you currently use to meet these needs? Are
there any gaps in provision? Could these be filled by Internet based resources - web
pages, email question and answer services, on-line discussion forums, and so on? Are
there resources on the Internet that enable you to meet needs you might not have met
before? What’s out there on the Internet anyway? What are other people using and doing
with it?

4. Make the connection between 2 and 3 for the people you’re trying to help. Providing
resources passively is not enough: you need to think about how to get people 
connected to the resource and services that meet their needs, without swamping them
with all the others that don’t. On the Web, for example, that’s not as easy as it sounds.
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What are their needs?

People need

• help with particular issues  - what are the most common issues in your experience?

• answers to questions - what are the most frequently asked questions? Do your 
colleagues agree?

• time to talk - what do they want to talk about, and to whom?

• information - what information do they most often want? What books, articles, 
TV programmes, web sites, are most regularly used?

• skills - to do what? to attain what?

• advice - what do they most often need advice about?

Only you, and your clients, can answer these questions – because only you know your
clients – and can ask them directly. Each group of clients may have different needs.

List the answers systematically. Do they fall into groups or clusters? How are these
clusters related? Can you produce some broader headings that include a number of
more specific needs?
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What’s available? What are the relevant
resources on the Internet?

Web sites - thousands that could have relevant information and advice, e.g.

• careers services locally, careers services in universities and colleges, employers,
employment agencies, colleges and universities, trades unions, voluntary 
organisations, citizens advice bureaux, careers book publishers, careers software
publishers, test publishers, government bodies and departments especially DfES,
JobCentre Plus, professional bodies, youth organisations, libraries, chambers of
commerce, research institutes, campaign groups, probation service, NACRO,
MIND, EOC, CRE, NIACE, Guidance Council, and so on

• these offer self assessment exercises, tests, information about all sorts of 
opportunities with facilities to retrieve what is relevant to the user, support for 
decision making, training for job search, advice on various aspects of career 
planning, tools to match the user’s qualities to relevant jobs and courses, and much
more that is also relevant to guidance, as well as support for the guidance 
practitioner’s own career development

Email - connecting anyone with an email address to anyone else with an email address

• making it possible to send more than one person the same message at the same
time without having to duplicate it first

• email lists which enable you to hold an on-going discussion with a group of 
people by email, provided they all have an email address through which they can
be contacted

Discussion forums or message boards 

• offering facilities to interact, discuss and share experiences with others without
them having to be there at the same time or place as you

Chat - “talk” with anyone on-line at the same time, with the same software

• like a telephone conversation using your keyboard rather than your voice

Videoconferencing – so you can communicate face to face with others at a distance

• so someone with scarce special expertise can help more people at a distance – e.g.
with test feedback

• you could help people in remote areas, or who are prevented by cultural barriers
from visiting you directly

Authoring facilities - publish on the Web without great computer skills

• create your own web page or something similar
• publish without waiting for a publisher
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How do we relate resources to needs?

Be clear about what you’re trying to achieve

How do you expect people will be different after using your services/resources?

DOTS The “DOTS” model offers a set of general headings that cover the needs you might
want to meet (listed here in the logical order: SODT). To make good choices in relation to
learning and work people need to have achieved: 

• Self Awareness - knowing myself, my interests, skills, personality, values 
and experience

• Opportunity Awareness - knowing the opportunities – e.g. courses, jobs
[matching SA and OA so as to focus on a manageable number of opportunities]

• Decision Learning - making the choice between the shortlisted items

• Transition Learning - implementing the decision, getting the job, getting on the
course, managing the transitions that result – getting the children looked after while
you do the course, finding the money to do it, and so on

The DOTS model was first described by Bill Law and Tony Watts of NICEC in 1977

FIRST An alternative set of headings was developed to measure the possible effect of a
guidance interview on the person interviewed. In mnemonic order, it stands for

• Focus - are they clearer about the issues and what they want to do?

• Information - do they have all the information they need?

• Realism - are they more realistic (a) about themselves (b) about the labour market?

• Scope - are they more aware of the range of opportunities to choose from?

• Tactics – do they know what the next steps are and how to get what they want?

[The “logical” order may be more like F/S, R,I,T]

“Vocational Guidance Interviews Revisited” Bedford, T., Dept. of Employment (1982)

What are your headings called?

Review your own headings from page 4. Do DOTS or FIRST subsume them? If not, that’s
no problem, so long as your own headings sum up the questions, issues and needs of
your target groups. Of course, they may be different for each group.

Now use your headings to group the resources you’d use to meet needs under each of
them - e.g. if you look at web pages in terms of DOTS, there are some that help with self
awareness, a lot that offer help with opportunity awareness, a few that offer decision
learning, and many that help with transition - especially if it’s transition to a (new) job. 

Take a look at the UK listing of web sites on http://www.guidanceforum.net. You’ll see
web sites grouped there under the DOTS headings. Is that a useful framework for you?
Or do you need to start a list of your own using your own headings?
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How much support do they need? How much
can you give?

People have needs, and you have resources. You need to bring the two together. But first
there’s one more thing to take into account. How much support or help do your people
need to use the resources you offer to meet their needs?

People need support at three broad levels:

1. Self help: Some people can do it on their own. They can get by on self-help resources.

2. Non-specialist help, or in a group: Some people need some help to get started and
some source of advice in case they get stuck but basically they can work it out 
themselves without lots of specialist advice or guidance. They can often get help from
each other in a group, for example.

3. Specialist help, one-to-one: Some people need a lot of help. They have significant 
difficulties, are indecisive, not just undecided, or they have extra social, cultural or 
economic disadvantages to overcome. They may need specialist support to use the
resources that meet their needs. They may need one-to-one attention.

Resources, too, exist at three broad levels:

1. Self help resources - many web pages are like that, intended for individual self-help.
So are some computer programs, and many books, videos, audiotapes etc.

2. Resources that are most effective when used with some support or advice. Some
more complex or interactive resources, computer-based systems, are like this - they
can be used on a self-help basis, but some advice on how to use them, or sharing
experience of using them, with others, can make the experience much richer and more
valuable. Work experience and taster courses are also like that. 

3. Resources that require specialist training or support to use effectively. Psychometric
tests of ability are a good example here - it is part of the ethics of test use that they are
only made available when you can be sure someone trained in their use is on hand to
provide feedback on results. Some sources of labour market data also need 
professional support to make sense of it. Such resources usually need to be used in a
one-to-one context, such as a guidance interview, itself a specialist resource.

What levels of support do you offer?

People, and resources, then, come in at several levels: your organisation may not offer
all three of these levels of service - self-help, supported, specialist/professional. You may
offer all three levels of service under some headings (opportunity awareness, say) but not
under others (e.g. decision making or self awareness). You may only offer group sessions,
or have no specialist trained guidance staff. You may simply not be able to afford
resources at the specialist level.
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The Resource Matrix

This offers a diagrammatic way of looking at the relationship between resources, needs,
and levels of service/support. What needs have you provided for in your organisation,
and what resources do you use to do that? Do you need more than one matrix – one for
each target group? A resource may be usable at a self-help level by one target group, but
only with support by another, and individuals within the same target group may differ in
the precise amount of support they need. Remember this is a two-dimensional 
representation of a multi-dimensional reality. It is intended as a prompt to your own 
thinking – it will not give all the answers to all the questions you face.

Are all the cells covered? What with?

Can you fill every cell with a resource from your organisation or elsewhere to meet the
need defined by it? [E.g. books, videos, leaflets, work experience placements, taster
courses, directories, computer programs, email services, web sites or pages, group work,
one-to-one discussion etc.]. Have you got some cells with duplicate resources in? Do you
cover too many with scarce or expensive resources such as a one-to-one guidance 
conversation or interview? Have you got any blank cells? Why? There may be a good 
reason (e.g. we don’t offer that to our clients) or it may be you just overlooked the need.
Do some cells need a combination of resources to meet the need with that level of 
support? Some cells will need more than one resource to meet the need defined by them.
One complex resource, on the other hand, may fill several cells, at more than one level
in more than one column.

Outcomes
& Needs >

Users/
Support

Level 1

Self help

Level 2
Non-

specialist
support -

or in group

Level 3

Specialist 

support

One to one

Self
Awareness

1

Opportunity
Awareness

2

Matching 
1&2

3

Decision
Learning

4

Transition
Learning

5
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Using the Resource Matrix

1. Become familiar with as many web sites and other Internet resources as you have
time for. If you don’t have time for everything, can you allocate the rest among your 
colleagues? Begin with the Gateway sites that look most appropriate – see the UK list of
web sites on 

http://www.guidanceforum.net for some suggestions, or visit 
http://www.careers-portal.co.uk/netguide/M4WWW.htm

If others have been that way before you, why not build on their experience and research?
You will find yourself revisiting some sites more often than others and soon the pathways
will start to become clearer to you, and you will start to branch out on your own. For adult
guidance, the Support4Learning web site is a particularly good starter 
http://www.support4learning.org.uk/

2. Group the sites you find useful as you go in terms of the broad headings you have
worked out that meet the clients’ needs. You could use the Resource Matrix, with your
own headings, to write down the web page addresses in the columns or rows they
belong to. Are you missing resources in any cell that you would like to cover with 
web-based resources? If so, can you think of some key words that would describe what
you’re looking for, and which you could then use in a search engine to find more 
material? (http://www.google.co.uk for example.)

3. Make a note for each site in terms of how much support you would want to give the
user - levels 1/2/3. This will help you to determine which cell in the matrix the site belongs
to.

4. Compare the web sites and other Internet resources with the resources and services
you already use to meet the needs (including things like face to face interviews, group
sessions, work experience, taster courses as well as books, videos, handouts etc.) Do any
of the technological resources and services 

• meet needs not already met by other resources ?

• meet them more effectively, more conveniently or more cheaply?

• meet the needs of groups you couldn’t have reached by other means with the 
traditional resources anyway?

5. What resources can you add other than web sites? Can you offer information or
advice to those you want to help by email? Can you put them in touch with each other to
exchange information, from a web site, an electronic notice board, or a simple email
address list? 

For more ideas on how to use and manage email and similar resources see
Developing Adult Guidance Skills: Working with Guidance Technology
National Extension College, (2002) ISBN 1 84308 061 3 
http://www.nec.ac.uk/resources/product?product_id=189&category_id=463

6. Involve the end-users themselves - what do they find most useful?
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Do it yourself

You don’t need a lot of technical knowledge and skill to develop useful tools and
resources with the Internet. Here are a few ideas to get you going.

The Web

Make a “favorites” or “bookmarks” list of sites you want to use, one for each client group
you serve. 

• Could this become a resource in itself - either on-line for clients to access - perhaps
the first page your browser opens on when they go on to the web* - a jumping off
point for answers to particular types of question asked about particular topics or by
particular groups of user? [*If you use Explorer as your browser select
Tools>Internet Options>General to see how you can make any web page, whose
address you type in, come up automatically when you start your browser.]

• Is it useful also as a paper-based handout for clients to take away and use by 
themselves? 

• Could you put the list on a disk for them to take away? Notice that in Word, and in
many other word processing systems, you can make a web page address into a
hyperlink (i.e. the reader can click on that address and be taken straight to the page
in question if they are on-line when reading, or start up their browser to do so, if
not). If you use Powerpoint you can do this, there too. (Select Insert> Hyperlink to
see the facility). A Word file or a few Powerpoint slides then become a simple key
for any individual or group of users to the effective use of the Web in e.g. job search
or self assessment or understanding local options, or answering the top ten 
questions they will ask even when you aren’t there to do this. 

• Could it be a reference for colleagues or other professionals who work with you?
Or for people (perhaps in other organisations) who support clients and need your
expertise to do it, but who don’t themselves have the training you have? It can also
be a training device – training in the use of the web in guidance but also in 
guidance more generally – depending on the framework you build around it.

• Could you turn it into an exercise for the user – taking them from one page to the
next, in logical progression, with some connecting text written by you? You could
use Word or Powerpoint or similar programs to do this quite easily, as we have
already said. For younger users, you might turn this into a ”treasure hunt” or a
guided tour…. If you would like some help and ideas about how to do this you
could visit http://www.kn.pacbell.com/wired/fil a site for teachers that provides
some simple help if you need your hand held, and allows you to create a web page
without any skill at all.

If you are more confident you might want to create your own web page or pages. There
are many tutorials on the web itself that help you with this. Try http://www.blogger.com
for one simple way of publishing your ideas on the web whether or not you have ever
done this before.

Email

• Of course, you can advise and inform people individually by email, if they have an
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email address. It’s easy to get a free one so long as you have access to the Internet
somewhere: that’s a useful skill for adults to gain, anyway, so you can achieve two
things in one process – introduce others to email, and encourage them to use it to
get help and advice.

• You can add several names to a list in your address book – see the help pages of
whatever system you use, for how to do this – it’s usually just a matter of typing
the email addresses in, separated by a comma. Then you can send emails to all of
the people on that list at one go. By clicking “reply to all” they can reply to 
everyone on that list, or they can just reply to you. You could run an on-line job
search group that way, or support people on a course, or work placement. If they
have the same list of addresses as you, they can also use the list to talk to each
other, and support each other.
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References - getting more help

Take a look at what others have done and experienced – visit the Survey page at
Guidanceforum.net http://www.guidanceforum.net/survey.htm

• You will see contributions from other guidance practitioners across Europe. Add
your own!

• You can also join the mailing list on the front page of the Guidanceforum.net web
site – type in your email address and then sign up to the (Yahoo-based) group 
discussion forum. [You could set up a similar group at Yahoo for your own clients
– it’s not difficult to do – and this would be one step beyond the email list we 
mentioned on the previous page].

• The UK list of links on the Guidanceforum.net site has already been mentioned. You
can find many more useful starting points there and from the lists offered by other
European partners in that project.

• There are some other resources, books and web sites that may help you. These
may be listed on the Guidanceforum.net web site, but the following are 
particularly useful:

Careers Professionals’ Guide to the Internet, Offer, M.S., Trotman Publishing, (2000) ISBN
0 85660 582 4. This book aims to offer something to complete beginners as well as to more
experienced practitioners with technical expertise. It is written in the style of a distance
learning programme. It is photocopiable, with case studies, exercises and a set of linked
web pages you can see at http://www.careers-portal.co.uk/netguide They will make much
more sense if you buy the book as well. For more details see Trotman’s catalogue at 
http://www.careers-portal.co.uk/professional/resources/?m=netguide.htm

Working with guidance technology - a part of a larger distance learning 
programme called Developing Adult Guidance Skills, National Extension College (2001),
ISBN 1 84308 061 3. See
http://www.nec.ac.uk/resources/product?product_id=189&category_id=463
There are sections on using email, and evaluation and quality standards as well as on
integrating ICT into guidance practice generally. The ring binder comes with a licence to
photocopy.

Center for the Study of Technology in Counseling and Career Development
This web site contains some interesting material on using the Internet in guidance. Some
of the ideas in this booklet derive from Professor Jim Sampson of the Center, at Florida
State University. http://www.career.fsu.edu/techcenter/

Connecting Careers and ICT A booklet and a web site. Mostly about the use of ICT in
careers education in schools, but some of this may be useful in an adult 
context, too. British Educational Communications and Technology 
Association (BECTA) (2001), DfES/Connexions Service National Unit. The web site is at
http://www.becta.org.uk/careersict

You can also contact the author of this booklet by email at 
marcusoffer@postmaster.co.uk
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